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著者: Ranjith M、Nidhin M S
関連製品ファミリ: すべての PSoC 4 製品
関連アプリケーション ノート: AN54181、AN77759
ソフトウェア バージョン: PSoC Creator™3.3 SP2 以降
本アプリケーション ノートの最新版については、
次のリンクにアクセスしてください: http://www.cypress.com/AN79953。
更なるサンプル コードが必要ですか？了解です。
常に増え続けている数百の PSoC サンプル コード リストにアクセスするには、当社のサンプル コードのウェブページをご覧ください。
また、PSoC 4 ビデオのライブラリについては、ここで調べることができます。
本アプリケーション ノート (AN79953) では、ARM® Cortex®-M0/M0+ベースのプログラム可能なシステムオンチップである
PSoC® 4 について紹介します。本資料は、開発者のお客様が PSoC 4 アーキテクチャとその開発ツールを探究するのに役立つ
他、PSoC Creator™という PSoC 4 用の開発ツールを使用して新規プロジェクトを作成する際に有用な案内をご提供します。
本アプリケーション ノートでは PSoC 4 を非常に深く正しく理解するためのリソースもご提供します。
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1
はじめに
PSoC 4 は、単一チップ上にカスタム アナログとデジタルの周辺機能、メモリ、および ARM Cortex-M0 または Cortex-M0+マ
イクロコントローラーを集積した、真のプログラマブル組込みシステムオンチップです。
本システムのタイプは、ほとんどのマイクロコントローラ ユニット (MCU) および外部アナログとデジタル ペリフェラルの組み合
わせを使用するミックスド シグナルの組み込みシステムと異なります。通常、それらのシステムは、MCU に加えて、 オペアンプ、
ADC や (ASIC) などの多くの集積回路を必要とします。
PSoC 4 は、MCU と外部 IC の組み合わせに代わるものとして、低コストのソリューションを提供します。システム全体のコスト
の削減に加えて、プログラマブルなアナログとデジタルのサブシステムにより高い柔軟性、設計のインフィールド チューニング、
および製品化までの時間縮小をご提供します。
PSoC 4 内の CapSense®という容量タッチ センシング特長は、信号対ノイズ比、クラス最高水準の防水、および前例のない
多種多様なセンサーのタイプ (ボタン、スライダ、トラック パッドや近接センサーなど) を提供します。
PSoC 4 は、SRAM、プログラマブルなロジック、および割り込みからウェイクアップする機能を保持しながら、150nA のクラス
最高の低電流消費量を提供します。PSoC 4 は、非保持の電力モードでウェイクアップ機能を保持しながら、消費電流は
20nA だけです。
PSoC 4 ファミリ デバイスは、Bluetooth® Low Energy (BLE) 無線システムを搭載する PSoC 4 BLE も含んでいます。PSoC
4 BLE の詳細については、AN91267 をご参照ください。
2
PSoC リソース
サイプレスは、www.cypress.com に大量のデータを掲載しており、ユーザーが適切な PSoC デバイスを選択し、デバイスを
デザインに迅速で効果的に統合する手助けをしています。リソースの包括的なリストについては、PSoC 3、PSoC 4、および
PSoC 5LP による設計方法 - KBA86521 をご参照ください。以下は PSoC 4 のリソースの要約です。





概要: PSoC ポートフォリオ、PSoC ロードマップ

製品セレクター: PSoC 1、PSoC 3、PSoC 4 ま
たは PSoC 5LP。さらに、PSoC Creator には
デバイス選択ツールが含まれています。
テ ク ニ カ ル リ フ ァ レ ン ス マ ニ ュ ア ル (TRM) : 各
PSoC 4 デバイス ファミリのアーキテクチャとレジスタ
の詳細なご説明をします。

PSoC トレーニング動画: これらの動画は PSoC を
どのようにして 複雑な設計を していくかについて、
ステップ バイス テップでご説明します。

開 発 キ ッ ト : CY8CKIT-040 、 CY8CKIT-041 、
CY8CKIT-042 、 CY8CKIT-044 、 CY8CKIT-046
および CY8CKIT-046 の PSoC 4 Pioneer Kit は使
いやすく、安価な開発プラットフォームです。これらは、
Arduino 準拠シールドおよび Digilent® Pmod™ドー
ター カード用のコネクタを搭載します。

CY8CKIT-043 お よ び CY8CKIT-049 は 、 PSoC
4200 デバイスをサンプリングするための低コストプロト
タイプ プラットフォームです。

MiniProg3 デバイスは、フラッシュのプログラムと
デバッグ用のインターフェースをご提供します。
データシート: PSoC 4000、 PSoC 4100 および
PSoC 4200、PSoC 4xx7 BLE、PSoC 4100M、
PSoC 4200M 、 PSoC 4200L, PSoC 4000S,
PSoC 4100S デバイス ファミリ用の電気的仕様
を提供し、説明します。
CapSense デザイン ガイド: PSoC 4 ファミリの
デバイスを使用して静電容量タッチセンシング
アプリケーションを設計する方法についてご説
明します。
アプリケーション ノートおよびサンプル コード:
基本レベルから上級レベルまでの幅広いトピック
を提供します。PSoC Creator はより多くのサン
プル コードを提供します。詳細については「サン
プル コード」をご参照ください。
www.cypress.com
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2.1
PSoC Creator
PSoC Creator は無料の Windows ベースの統合開発環境 (IDE) です。このキットにより、PSoC 3、PSoC 4 および
PSoC 5LP システムについて、ハードウェアとファームウェアの同時並行の設計が可能です。図 1 に示すように、PSoC
Creator を使用すれば、以下のことを実現できます。
1.
コンポーネントをドラッグ アンド ドロップして、
ハードウェア システム デザインを構築
4.
100 以上のコンポーネントのあるライブラリを
利用
2.
アプリケーションのファームウェアと PSoC ハード
ウェアの相互設計
5.
コンポーネント データシートを確認
3.
コンフィギュレーション ツールを用いて、コンポー
ネントを構成
図 1. PSoC Creator の機能
www.cypress.com
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2.2
図 2. PSoC Creator のサンプル コード
サンプル コード
PSoC Creator は多数のサンプル コード プロジェクトを提供していま
す。これらのプロジェクトは、図 2 に示すように、PSoC Creator の
スタート ページからアクセスできます。
サンプル プロジェクトは、最初 (空のページ) からではなく完成した
設計で始めれることにより、設計時間を短縮させることができます。
サンプル プロジェクトは、PSoC Creator コンポーネントを様々な
アプリケーションに使用する方法も示します。図 3 に示すようにサンプル
コードおよびデータシートが含まれています。
図 3 に示す Find Example Project ダイ ア ログにはいくつかの
オプションがあります。

アーキテクチャまたはデバイス ファミリ (PSoC 3、PSoC 4、
PSoC5 LP など)、カテゴリ、またはキーワードに基づいてサンプル
プロジェクトのためにフィルタ処理します。

「Filter Options」に基づいてフィルターされたリストからサンプル
プロジェクトを選択します。

選択したプロジェクトのデータシートをレビューします
(Documentation タブで)。

選択のためにサンプル コードをレビューします。このウィンドウ
からコードをコピーしプロジェクトに貼り付けてコード開発時間を
短縮させることができます。

選択にもとづいて新規プロジェクト (および、必要な場合は新規ワーク
スペースも) を作成することができます。これにより、完備した基本設
計で開始し、設計プロセスをスピードアップすることができます。その
ようにして設計をアプリケーションに適合させることが可能です。
図 3. サンプル プロジェクトおよびサンプル コード
www.cypress.com
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2.3
PSoC Creator ヘルプ
PSoC Creator ホームページへアクセスして PSoC Creator の最新版をダウンロードしてください。次に、PSoC Creator を
起動して、以下のアイテムへナビゲートします:
2.4

クイック スタート ガイド: Help > Documentation > Quick Start Guide を選択します。このガイドは PSoC Creator
プロジェクトを開発するための基礎知識を提供します。

簡単なコンポーネント サンプル プロジェクト: File > Open > Example projects を選択します。これらのサンプル
プロジェクトは、PSoC Creator のコンポーネントの設定と使用方法を示します。

システム リファレンス ガイド: Help > System Reference > System Reference Guide を選択します。このガイドは、
PSoC Creator により提供されるシステム機能を一覧にして、説明します。

コンポーネント データシート: コンポーネントを右クリックして「データシートを開く」を選択します。全ての PSoC 4 のコンポー
ネント データシートの一覧を表示するには、次のページへアクセスしてください:PSoC 4 のコンポーネント データシート。


PSoC Creator トレーニング動画: これらの動画は PSoC Creator 入門のステップ バイ ステップ方法を提供します。
ドキュメント マネージャー: PSoC Creator が提供するドキュメント マネージャーにより、ドキュメント リソースを容易に
検索し、確認できます。Document Manager を開くには、メニューアイテムの Help >Document Manager を選択します。
テクニカル サポート
ご質問は、弊社のテクニカル サポート チームが対応いたします。 Cypress Technical Support ページにアクセスし、サポート
リクエストを作成してください。
米国のお客様は、テクニカル サポート チームに連絡する際、以下の電話番号 (通話無料) にお問い合わせください:
+1-800-541-4736 プロンプト上のオプション「8」を選択してください。
緊急サポートが必要な場合は、以下のサポート リソースをご利用ください。


セルフ ヘルプ
所在地の販売代理店
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3
PSoC 4 の機能セット
PSoC 4 は、 図 4 に示すように、CPU とメモリ サブシステム、デジタル サブシステム、アナログ サブシステム、システム
リソースを含む幅広い機能を備えています。次の節は各機能について簡単に説明します。詳細については、PSoC 4 ファミリの
デバイス データシート、テクニカル リファレンス マニュアル (TRM) および PSoC リソースにリストアップされたアプリケー
ション ノートをご参照ください。
図 4. PSoC 4 アーキテクチャ (PSoC 4200L)
CPU Subsystem
PSoC 4200L
SWD/TC
SPCIF
Cortex
M0
32-bit
FLASH
256 KB
SRAM
32 KB
ROM
8 KB
DataWire/
DMA
Read Accelerator
SRAM Controller
ROM Controller
Initiator/MMIO
48 MHz
FAST MUL
NVIC, IRQMUX
AHB-Lite
System Resources
System Interconnect (Multi Layer AHB)
Peripherals
UDB
x1
x8
CTBm
2x OpAmp
x2
FS-PHY
Port Interface & Digital System Interconnect (DSI)
High Speed I/O Matrix, 1x Programmable I/O
Power Modes
Active/Sleep
DeepSleep
Hibernate
CHG-DET
SARMUX
USB-FS
...
WCO
UDB
512B
2x CAN
SAR ADC
(12-bit)
LCD
Programmable
Digital
2x LP Comparator
Reset
Reset Control
XRES
Programmable
Analog
4x SCB-I2C/SPI/UART
IOSS GPIO (13x ports)
Clock
Clock Control
WDT
IMO
ILO
ECO
2x PLL
2x CapSense
Peripheral Interconnect (MMIO)
PCLK
8x TCPWM
Power
Sleep Control
WIC
POR
LVD
REF
BOD
PWRSYS
NVLatches
80x GPIOs, 14x GPIO_OVT, 2x SIO
IO Subsystem
表 1 に、異なるファミリの一番大きな容量のデバイスの機能を示します。デバイスによって、これらの機能の全部または一部
が使用可能です。詳細については、PSoC 4 製品セレクタ ガイドをご参照ください。
表 1. PSoC 4 デバイス ファミリ
デバイス ファミリ
特長
CY8C4000S
CY8C4100
CY8C4100S
CY8C4200
CY8C4200M
CY8C4200L
CPU
16MHz
Cortex-M0
CPU
シングル サイ
クルの乗算に
対応した
48MHz
Cortex-M0+
シングル サイ
クルの乗算に
対応した
24MHz
Cortex-M0
シングル サイ
クルの乗算に
対応した
48MHz
Cortex-M0+
シングル サイ
クルの乗算に
対応した
48MHz
Cortex-M0
シングル サイ
クルの乗算に
対応した
48MHz
Cortex-M0
シングル サイク
ルの乗算に対応
した 48MHz
Cortex-M0
DMA
該当なし
該当なし
該当なし
該当なし
該当なし
8 チャネル
32 チャネル
フラッシュ
メモリ
16KB
32KB
32KB
64KB
32KB
128KB
256KB
SRAM
2KB
4KB
4KB
8KB
4KB
16KB
32KB
CY8C4000
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デバイス ファミリ
特長
CY8C4000
CY8C4000S
CY8C4100
CY8C4100S
CY8C4200
CY8C4200M
CY8C4200L
GPIO
20
36
36
36
36
55
96
CapSense
16 センサー
35 センサー
35 センサー
35 センサー
35 センサー
54 センサー
94 センサー
ADC
なし
10 ビット、
46ksps シング
ル スロープ
ADC
シーケンサー
を備えた 12 ビ
ット、806ksps
SAR ADC
シーケンサー
を備えた 12 ビ
ット、1-MSPS
SAR ADC
シーケンサー
を備えた 12 ビ
ット、1-MSPS
SAR ADC
シーケンサー
を備えた 12
ビット、1MSPS SAR
ADC
シーケンサーを
備えた 12 ビッ
ト、1-MSPS
SAR ADC
オペアンプ
なし
なし
2 個のプログラ
ム可能なオペ
アンプ
2 個のプログラ
ム可能なオペ
アンプ
2 個のプログ
ラム可能なオ
ペアンプ
2 個のプログ
ラム可能なオ
ペアンプ
4 個のプログラ
マブルなオペア
ンプ
コンパレー
タ
固定閾値
(1.2 V) の
1 個の CSD
コンパレータ
ウェイクアップ
機能を
備えた 2 個の
低消費電力
コンパレータ
ウェイクアップ
機能を
備えた 2 個の
低消費電力
コンパレータ
ウェイクアップ
機能を
備えた 2 個の
低消費電力
コンパレータ
ウェイクアップ
機能を
備えた 2 個の
低消費電力
コンパレータ
ウェイクアップ
機能を備えた
2 個の
低消費電力
コンパレータ
ウェイクアップ機
能を備えた 2 個
の低消費電力
コンパレータ
IDAC*
7 ビット (1
個) と 8 ビット
(1 個)
7 ビット (2 個)
7 ビット (1 個)
と 8 ビット (1
個)
7 ビット (2 個)
7 ビット (1 個)
と 8 ビット (1
個)
7 ビット (2 個)
と 8 ビット (2
個)
7 ビット (2 個) と
8 ビット (2 個)
4 個の UDB
あり、各々は
8 つのマクロ
セルおよび 1
つのデータパ
ス付き
8 個の UDB あ
り、各々は 8 つ
のマクロセルお
よび 1 つの
データパス付き
プログラム
可能な論
理ブロック
(UDB)
なし
なし
なし
なし
4 個の UDB
あり、各々は 8
つのマクロセ
ルおよび 1 つ
のデータ
パス付き
スマート IO
ポート
なし
2
なし
2
なし
なし
1
電源電圧
範囲
1.71V～5.5V
1.71V～5.5V
1.71V～5.5V
1.71V～5.5V
1.71V～5.5V
1.71V～5.5V
1.71V～5.5V
ディープスリー
プ モードでは
2.5µA
ディープスリー
プ モードでは
1.3µA； ハイバ
ネート モードで
は 150nA；
ストップ モード
では 20nA
ディープスリー
プ モードでは
2.5µA
ディープスリー
プ モードでは
1.3µA；ハイバ
ネート モードで
は 150nA；
ストップ モード
では 20nA
ディープスリー
プ モードでは
1.3µA； ハイバ
ネート モード
では 150nA；
ストップ モード
では 20nA
ディープスリープ
モードでは
1.3µA；
ハイバネート モ
ードでは 150nA；
ストップ モードで
は 20nA
なし
4 個の COM
セグメント
LCD ドライブ
4 個の COM
セグメント
LCD ドライブ
4 個の COM
セグメント LCD
ドライブ
4 個の COM
セグメント
LCD ドライブ
4 個の COM
セグメント
LCD ドライブ
8 個の COM
セグメント LCD
ドライブ
シリアル通
信
1 個の I C
I C、SPI また
は UART にプ
ログラム可能
な 2 個のシリ
アル通信ブロ
ック (SCB)
I C、SPI また
は UART にプ
ログラム可能
な 2 個のシリ
アル通信ブロ
ック (SCB)
I C、SPI また
は UART にプ
ログラム可能な
3 個のシリアル
通信ブロック
(SCB)
I C、SPI、また
は UART に
プログラム
可能な 2 個の
SCB
I C、SPI、ま
たは UART
にプログラム
可能な 2 個の
SCB
I C、SPI、また
は UART に
プログラム
可能な 4 個の
SCB
タイマー／
カウンタ／
パルス幅
変調器
(TCPWM)
1
5
4
5
4
8
8
低消費電
力 モード
セグメント
LCD 駆動
ディープスリ
ープ モードで
は 2.5µA
2
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デバイス ファミリ
特長
CY8C4000
コントローラ
ー エリア ネ
ットワーク
(CAN)
ユニバーサ
ル シリアル
バス (USB)
クロック
なし
なし
24MHz／
32MHz 内部
主発振器
(IMO)
32kHz 内部
低速発振器
(ILO)
電源監視
パワーオン
リセット
(POR)
電圧低下検
出 (BOD)
CY8C4000S
なし
なし
24MHz～48MHz IMO
40kHz ILO
32kHZ の時計
用水晶発振器
(WCO)
CY8C4100
なし
なし
3MHz～
24MHz IMO
32kHz ILO
CY8C4100S
なし
なし
24MHz～48MHz IMO
40kHz ILO
32kHZ WCO
なし
なし
3MHz～
48MHz IMO
32kHz ILO
CY8C4200M
CY8C4200L
2
2
なし
8 つのエンドポイ
ントのあるフル
スピード USB
デバイス
3MHz～
48MHz IMO
32kHz ILO
32kHz WCO
3MHz～48MHz
IMO
4MHz～33MHz
の外部水晶発振
器 (ECO)
32kHz ILO
32kHz WCO
POR、BOD
POR、 BOD
CY8C4200
低電圧検出
(LVD)
POR、BOD
POR、BOD、
LVD
POR、BOD、
LVD
POR、BOD、
LVD
*CapSense が使用されない場合のみに、IDAC は使用可能です。詳細については、それぞれの PSoC 4 テクニカル リファレンス
マニュアルをご参照ください。
4
PSoC の MCU より優れている点
図 5 に示すように、標準的な MCU は、CPU (8051 または ARM Cortex など) および ADC、DAC、UARTS、SPI 等のペリフェラル
機能、および汎用 I/O を含みます。これらはすべて CPU のレジスタ インターフェースにリンクします。MCU 内で、CPU は
デバイス の「心臓」です。CPU はセットアップ、データ移動、タイミングなどをすべての処理を管理します。CPU がないと、
MCU は機能できません。
図 6 に示すように、PSoC は全く違います。PSoC により、CPU、アナログ、デジタルおよび I/O は、プログラマブルなシステム
で同等に重要なリソースです。 PSoC の心臓は CPU ではなく、システムの相互接続とプログラマビリティです。ペリフェラル
アナログとデジタルは高度にコンフィグレーション可能な信号マトリックスおよびデータバスメッシングと相互接続されます。
これにより、ユーザーはアプリケーションの要件を満たすカスタム設計を作成することができます。PSoC をプログラムして
MCU をエミュレートできますが、 MCU をプログラムして PSoC をエミュレートできません。
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図 5. 標準 MCU のブロック図
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図 6. PSoC のブロック図
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(IDACs, Comparators, Touch Sensing)
Gen IO
Gen IO
標準的な MCU は、ステート マシンを処理し、タイマーをタイミングに使用し、出力ピンを駆動するために、CPU ファームウェアを
必要とします。従って、機能的なパスはほとんどの場合、CPU を介します。しかし、PSoC では非同期の平行処理は可能で
す。PSoC のコンポーネントが CPU から独立して動作するように設定することができます。このアプリケーション ノートに組み
込まれるプロジェクトはこの概念を示します。PSoC は CPU にコードを書かずに LED を点滅させるように設定されます。
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4.1
PSoC Creator コンポーネントのコンセプト
PSoC のその他の大切な点は PSoC Creator IDE の使用可能性です。PSoC Creator では、異なる PSoC リソースは設計を
迅速にビルドするために、回路図にドラッグ アンド ドロップできるコンポーネントと呼ばれているグラフィック要素として構成さ
れます。すべての PSoC のペリフェラルは、検証済み PSoC Creator コンポーネント (PWM コンポーネント、ADC コンポーネント、
DAC コンポーネント、CapSense コンポーネント、UART コンポーネントなど) として使用できます。PSoC Creator の検証済み
コンポーネントを使用することにより開発時間を著しく短縮します。またさらに、グラフィック オプションを用いて、設計も迅速に
変更できます。
たとえば、標準マイクロコントローラーで PWM を設定して、LED を点滅させるためには、下記が必要です:
1.
PWM ブロックに対応したレジスタを位置付け
2.
要求される PWM 周期およびデューティ比に基づいて、PWM レジスタに書き込まれる値を計算
3.
PWM レジスタを設定するために数多くのコード ラインを書き、ピン ドライブ モードを設定し、PWM 出力をピンに接続。
数多くの MCU は内部ブロックに接続するために、代わりのピンは提供しない
PSoC では、これらのような機能は本アプリケーション ノートで後述される簡単な操作で実装できます。タイマーに同じ PWM
ブロックを再設定する場合は、PSoC Creator ではわずかなマウス クリックだけです。それ以上の手間はかかりません！
PSoC にはユニバーサル デジタル ブロック (UDB) として知られるプログラム可能なデジタル ブロックもあります。PSoC
Creator は UDB からできている、UART、SPI、I2S、タイマー、PWM、カウンター、デジタル ゲート (AND、OR、NOT、XOR)
などのコンポーネントも提供します。PSoC Creator で UDB を使用して、自分のカスタム ステート マシーンおよびデジタル
ロジックを作り上げることが可能です。自分の PSoC Creator コンポーネントを作り上げる方法については、 PSoC®
Creator™コンポーネント作成者ガイドをご参照ください。
5
はじめての PSoC 4 設計
この節は次のことをします:



従来の MCU 以上のことができるように PSoC をプログラムするデモンストレーション
単純な PSoC の設計をビルドし、それを開発キットにインストールする方法の提示
PSoC 設計技術の学習を容易にする詳細な手順と、PSoC Creator IDE の使用方法の提示
5.1
インストールの前に
5.1.1
PSoC Creator をインストールしましたか？
PSoC Creator ホームページから PSoC Creator をダウンロードし、インストールします。ツールセットのインストールは時間が
かかることに注意してください。詳細については、PSoC Creator リリース ノートをご参照ください。
5.1.2
開発キットがありますか？
この設計のテストには、プログラマを搭載した、表 2 に示すキットの 1 つが必要です。
表 2. PSoC 4 Pioneer Kit および対応のデバイスの一覧
Pioneer Kit
対応のデバイス ファミリ
製品番号
CY8CKIT-040
PSoC 4000
CY8C4014LQI-422
CY8CKIT-041
PSoC 4000S
CY8C4045AZI-S413
CY8CKIT-041
PSoC 4100S
CY8C4146AZI-S433
CY8CKIT-042
PSoC 4200
CY8C4245AXI-483
CY8CKIT-043
PSoC 4200M
CY8C4247AZI-M485
CY8CKIT-044
PSoC 4200M
CY8C4247AZI-M485
CY8CKIT-046
PSoC 4200L
CY8C4248BZI-L489
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上記のいずれかのキットを持っている場合、パート 1: 設計の作成の節に進んでください。
プログラマの代わりに USB-シリアル ブートローダを備える CY8CKIT-049 を使用する場合、本アプリケーション ノートととも
に提供される CY8CKIT_049_Example をご使用ください。AN79953 ランディング ページから AN79953.zip の一部として
それをダウンロードできます。このサンプル プロジェクトを CY8CKIT-049 にブートロードする方法については、お使いの
CY8CKIT-049 のブートロードの節に進んでください。
この設計の代わりにキットと共に提供されるサンプル コードを評価することも可能です。詳細については、キット ガイドの
「サンプル コード」を参照してください。CY8CKIT-049 キット ウェーブページにアクセスして、キット ガイドおよびサンプル
コードをダウンロードしてください。
5.1.3
実行中のプロジェクトをご覧になりたいですか？
ユーザーが設計過程を追いたくない場合は、http://www.cypress.com/go/AN79953 において、完成した PSoC Creator プロジェクト
を取得できます。そして、ビルドおよびプログラムのステップへ進むことができます。
5.2
設計について
図 7 に示すように、この設計は TCPWM コンポーネントを使用し、シンプルに 2 個の LED を点滅させます。TCPWM は
PWM モードで設定されます。PWM の 2 個の相補出力は LED を制御します。PWM は、LED のトグルが見えるように、非常
に低い周波数と 50 パーセントのデューティ比で動作します。2 個の個別の LED の代わりにデュアル カラーLED を使用する
と、このプロジェクトはデュアル カラーLED の色をトグルできます。
図 7. はじめての PSoC 4 設計
5.3
パート 1: 設計の作成
この節は設計プロセスの概要について順に説明します。空のプロジェクトを作成してから、ハードウェアとファームウェア設計
入力について解説します。
1.
PSoC Creator を起動して、図 8 に示すように、File メニューから New > Project を選択します。
図 8. 新規プロジェクトの作成
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2.
ポップアップ ウインドウで開発キットを選択します。例として、CY8CKIT-042 をお持ちの場合、 キット: CY8CKIT-042
(PSoC 4100 / PSoC 4200) を選択して、 Next をクリックしてください。メニューにユーザーの PSoC 4 開発キットがない
場合、サイプレスのウェブサイトからキット セットアップをダウンロードし、インストールします。
または、ターゲット ハードウェアの代わりに、ターゲット デバイス ラジオ ボタンを選択して適切なデバイスを選んで、
Next をクリックすることも可能です。
図 9. 新しい空の PSoC 4 プロジェクトの作成
3.
次のウインドウから Empty Schematic オプションを選択し、Next をクリックします。
図 10. 「Empty Schematic」の選択
4.
以図に示すように、プロジェクト名 (例えば「My_First_Project」) およびワークスペース名をつけます。新規プロジェクトに
適切な場所 (Location) を選択して、Finish をクリックしてください。
www.cypress.com
文書番号: 001-89249 Rev. *C
12
®
PSoC 4 入門
5.
Workspace Explorer (図 11 を参照) に示すように、新規プロジェクトを作成すると、ファイルのベースライン セットを
含んでいるプロジェクト フォルダが作成されます。TopDesign.cysch をダブルクリックして、プロジェクトの回路図ファイル
を開きます。
図 11. TopDesign 回路図の開き
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6.
図 12 に示すように、コンポーネント カタログから回路図に 1 つの PWM (TCPWM モード) コンポーネントをドラッグします。
図 12. PWM コンポーネントの位置
7.
図 13 に示すように、回路図の PWM コンポーネントをダブルクリックして、コンポーネントのプロパティを構成します。
PWM タブをクリックして、周期値を 254 に、比較値を 127 にセットして、デューティ比が 50 パーセントの PWM 信号を
生成します。
入力クロック周波数を 8 で分割するために、Prescaler を 8x にセットします。
図 13. PWM コンポーネントの設定
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8.
PWM コンポーネントは、動作用に 1 つの入力クロックを必要とします。図 14 と図 15 に示すように、回路図に Clock
コンポーネントをドラッグ アンド ドロップし、コンポーネントでダブル クリックして、Frequency を 800Hz に設定します。
PWM コンポーネントで Prescaler 値が 8 に設定されたため、PWM 入力クロックは 100Hz のみです。従って、PWM 周
期が 254 に設定されたので、PWM 出力周期は 2.54 秒になります。
図 14. クロック コンポーネントの位置
図 15. クロック コンポーネントの設定
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9.
Digital Output Pin コンポーネントをドラッグ アンド ドロップします。図 16 と図 17 に示すように、その名前を LED_1 に
変更します。他のデジタル出力ピン コンポーネントを追加して、LED_2 と名付けます。
図 16. デジタル出力ピン コンポーネントの位置
図 17. ピン コンポーネントの再名付け
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10. 回路図ウインドウで、図 18 に示すように、ワイヤー ツールを選択し、または W を押します。
図 18. ワイヤー ツールの選択
11. 図 19 に示すように、コンポーネントを一緒に配線します。
図 19. 回路図の配線
12. ほとんどのコンポーネントはデバイス リセットで無効になります。クロック コンポーネントは重要な例外で、デフォルトで
自動的に起動されます。これらのコンポーネントを有効するように、プロジェクトにコードを追加する必要があります。
Workspace Explorer から main.c を開き、コード 1 のように、コードを main()関数に追加します。
コード 1. PWM コンポーネントの有効化
int main()
{
/* Enable and start the PWM */
PWM_1_Start();
for(;;)
{
}
}
13. ビルド メニューから Build My_First_Project を選択します。図 20 に示すように、Workspace Explorer ウィンドウでは、
PSoC Creator が PWM、クロックとデジタル出力ピン コンポーネントに対しソース コード ファイルを自動的に生成する
ことに注意してください。
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図 20. 生成されたソース ファイル
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14. Workspace Explorer から My_First_Project.cydwr (Design-Wide Resource ファイル) ファイルを開けて、Pins タブを
クリックします。このタブで LED_1 と LED_2 出力用のデバイス ピンを選択します。
図 21 に、CY8CKIT-042 PSoC 4Pioneer Kit で LED_1 と LED_2 ピンを緑と赤色 LED に接続するピン コンフィギュ
レーションを示します。別の PSoC 4 キットをお使いの場合、表 3 をご参照ください。
図 21. ピンの選択
表 3. Pioneer Kit のピン マッピング表
機能
CY8CKIT-040
(PSoC 4000)
CY8CKIT-041
(PSoC 4000S / PSoC 4100S)
CY8CKIT-042
(PSoC 4200)
CY8CKIT-044
(PSoC 4200M)
緑色の LED
(アクティブ LOW)
P1[1]
P2[6]
P0[2]
P2[6]
赤色の LED
(アクティブ LOW)
P3[2]
P3[4]**
P1[6]
P0[6]
CY8CKIT-046
(PSoC 4200L)
P5[2]
P5[3]
*PSoC 4000 製品は、相補 PWM 出力用の固定のピン (P1[1]と P1[6]) を備えています。PWM 出力に他のピンを使用する
ことができません。詳細については、デバイスのデータシートをご参照ください。CY8CKIT-040 を使用する場合、P1[1]に接続
された緑色 LED を LED1 として使用できます。赤色 LED を LED2 として使用するには、ワイヤーを使ってヘッダーJ4 の
P3[2]をヘッダーJ3 の P1[6]に接続してください。また LED2 として P1[6]に外部 LED を接続できます。
** 上記のノートと同様に、CY8CKIT-041 を使用している場合、P2[6]に接続された緑色の LED を LED1 として使用し、LED2
用にコンプリメンタリーPWM 出力 P2[7]を選択できます。赤色 LED を LED2 として使用するには、ワイヤーを使ってヘッダー
J2 の P3[4]をヘッダーJ3 の P2[7]に接続してください。また LED2 として P2[7]に外部 LED を接続できます。
注: CY8CKIT-043 および CY8CKIT-049 では P1[6]に接続している LED は 1 つだけです。CY8CKIT-049 をお使いの場合、
1 個の外部 LED をピン P0[2]に接続できます。
15. 最後に、ステップ 12 で説明したようにプロジェクトを再ビルドします。
16. CY8CKIT-049 をお 使い でない 場合、 次の節に進んでく ださい 。 CY8CKIT-049 をお 使い の場合、 プロジ ェク トを
CY8CKIT-049 にブートロード可能なプロジェクトに変換の節に進んでください。
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5.4
パート 2: デバイスのプログラム
本節は、デバイスをプログラムする方法を説明します。CY8CKIT-040、CY8CKIT-041、CY8CKIT-042、CY8CKIT-044、ま
たは CY8CKIT-046 を使用する場合、USB ケーブルを使ってキット ボードをコンピューターに接続します。
1.
図 22 に示すように、PSoC Creator メニューから、Debug > Select Debug Target を選択します。
図 22. デバッグ ターゲットの選択
2.
図 23 に示すように、Select Debug Target ダイアログ ボックスでは、Port Acquire をクリックしてから、Connect を
クリックします。OK をクリックして、ダイアログ ボックスを閉じます。
図 23. デバイスへの接続
3.
図 24 に示すように、Debug > Program を選択して、プロジェクトでデバイスをプログラムします。
図 24. デバイスのプログラム
4.
図 25 に示すように、プログラミングの状態はステータス バー (画面の左下隅) に表示されます。
図 25. プログラミングの状態
5.
デバイスがプログラムされてから、LED のトグルをチェックしてプロジェクトの動作を検証します。
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5.5
プロジェクトを CY8CKIT-049 にブートロード可能なプロジェクトに変換
1.
Workspace Explorer で TopDesign.cysch をダブルクリックして、TopDesign 回路図へ移動します。
2.
Component Catalog から TopDesign 回路図へ Bootloadable コンポーネントをドラッグ アンド ドロップします。
3.
ブートローダブル コンポーネントをダブルクリックし、Dependencies タブをクリックして、キットに含まれている UART
ブ ー ト ロ ー ダ プ ロ ジ ェ ク ト か ら .hex フ ァ イ ル と .elf フ ァ イ ル を 選 択 し ま す (\CY8CKIT-04942xx\\Firmware\SCB_Bootloader\UART_Bootloader.cydsn\CortexM0\ARM_GCC_484\Debug\)。これにより、
キット上で動作しているブートローダにブートローダブル プロジェクトを指すようになります。Apply をクリックし、それから
OK をクリックします。
図 26. 依存する UART ブートローダ プロジェクトの追加
4.
5.6
最後に、Build メニューから Build My_First_Project を選択し、プロジェクトを再ビルドします。
お使いの CY8CKIT-049 のブートロード
CY8CKIT-049 はその他の PSoC 4 開発キットと少し異なります。CY8CKIT-049 はプログラマを搭載していないため、ブート
ロードする必要があります。ブートロードの詳細については、AN73854 をご参照ください。本アプリケーションノートと共に提供
されるサンプル プロジェクトを CY8CKIT-049 にブートロードするために、以下の手順に従ってください。
1.
CY8CKIT-049-4xxx プロトタイピング ボードを PC に接続します。キットをポートに接続する場合、キットが接続されている
間に SW1 ボタンを押します。青色の LED が速く点滅し始めます。これは、PSoC 4 が「ブートローダ モード」に入り、
最新のファームウェアをロードされる準備ができていることを示します。PSoC 4 をブートロードする度に、その操作を行う
必要があります。
2.
Tools > Bootloader Host を選択して、 ブートローダ ホスト ツールを開きます。
図 27. ブートローダ ホスト ツールの起動
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ブートローダ ホスト ツールが開きます。
図 28. ブートローダ ホスト ツール
3.
Filters をクリックし、ポート フィルター ウインドウから Show UART Devices オプションを選択してから、OK をクリックし
ます。コンピューターに接続されるすべての COM デバイスはここに表示されます。
注: ブートローダの PID は F13B です。キットのブートローダのみを表示するために、ポート フィルター ウインドウにこの
PID を入力できます。
図 29. ポート フィルター
ここで、ブートローダ ホスト ツールはすべての使用可能な UART ベースの COM ポートを表示します。
4.
使用可能なポートのリストから COM ポートをクリックし、USB-シリアル デバイスでの USB-UART コンフィギュレーション
用の UART コンフィギュレーション (ボーレート、データ ビット、ストップ ビットおよびパリティなど) を入力します。
UART 用の値は 115200 ボーレート、8 データ ビット、1 ストップ ビットおよびパリティ無しです。
5.
File > Open を ク リ ッ ク し 、 ユ ー ザ ー の プ ロ ジ ェ ク ト ダ イ レ ク ト リ ー の CortexM0 フ ォ ル ダ で 生 成 さ れ た
My_First_Project.cyacd ファイルへ移動してから、Open をクリックします。
図 30. 生成されたファイルの開き
6.
Program ボタンをクリックして、新規のアプリケーション コードをデバイスにロードします。ステータス ウインドウは、出力
メッセージ、およびプログラム進捗を示すステータス バーを表示します。ブートロードが完了する時、ユーザーのアプリケー
ションは最新版のアプリケーション コードで実行します。
図 31. アプリケーション コードによるデバイスのプログラム
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5.7
その他の PSoC 4 のサンプル コード
サイプレスのウェブサイトにはその他の PSoC 4 のサンプル コードがあります。下図に、PSoC4 ファミリのデバイスのさまざ
まなブロックの累積的な表現を示します。各ブロックのサンプルは次項で分類されます。対応するサンプル コード リンクへ
移動するために、PSoc 4 のいずれかのブロックをクリックします。
®
PSoC 4
MCU サブシステム
プログラム可能なアナログ
ブロック
GPIO
SAR
ADC
オペアンプ
CortexM0/M0+
48MHz
I/O サブシステム
GPIO
GPIO
CMP
CSD
シリアル ワイヤ デバッガ
7 ビット
IDAC
プログラム可能なデジタル
ブロック
UDB
CAN
スマート IO (いくつかポート上にある)
SRAM
8 ビット
IDAC
プログラム可能な相互接続および配線
フラッシュ
高度高性能バス(AHB)
GPIO
GPIO
GPIO
GPIO
GPIO
GPIO
TCPWM
フルスピード
USB 2.0
RTC
DMA
5.7.1
GPIO
SCB – I2C, SPI, UART
GPIO
セグメント LCD ドライブ
GPIO
C P U – AR M C o r t e x M 0 / C o r t e x M 0 +
PSoC® 4 ARM Cortex-M0 コアは低消費電力動作に最適化された 32 ビットの CPU です。高い効率の 3 段パイプライン
および 4GB の固定メモリがあり、ARMv6-M Thumb 命令セットに対応します。Cortex-M0 は 32 ビットのシングル サイクル
乗算命令およびレイテンシの短い割り込み処理にも対応します。CPU コアに密接にリンクされるその他のサブシステムは
ネスト型ベクタ割り込みコントローラー (NVIC)、SYSTICK タイマー、およびデバッグ機能を含みます。PSoC 4000S および
PSoC 4100S の ARM Cortex-M0+は、より良い電力効率が得られる 2 段のコア パイプラインを備えた Cortex-M0 の最適化
されたスーパーセットです。
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表 4. CPU サブシステム アプリケーション ノート
文書番号
5.7.2
文書名
®
AN90799
「PSoC 4 Interrupts」
AN89610
「PSoC 4 and PSoC 5LP ARM Cortex Code Optimization」
®
メ モ リ - フ ラ ッ シ ュ お よ び S R AM
PSoC 4 デバイスは、フラッシュ ブロックからの平均アクセス時間を改善するために、CPU に緊密に結合されたフラッシュ
アクセラレータ付きのフラッシュ モジュールを持っています。フラッシュ アクセラレータはシングル サイクル SRAM のアクセス
性能平均 85%を達成します。必要に応じて、EEPROM 動作をエミュレートするためにフラッシュ モジュールの一部を使用
できます。SRAM メモリはハイバネート モード中に保持されます。
表 5. エミュレートした EEPROM サンプル コード
文書番号
CE95313
5.7.3
文書名
「Emulated EEPROM memory with PSoC 3/4/5LP」
DMA
PSoC 4200L は 32 個のチャネルを備えた DMA エンジンを内蔵しています。このエンジンはペリフェラル間、メモリ間、または
ペリフェラルとメモリ間で 32 ビットを転送できます。
表 6. PSoC 4 DMA コンポーネント データシート
文書番号
001-96043
5.7.4
文書名
「PSoC 4 Direct Memory Access (DMA) Channel」コンポーネント データシート
システム リソース – クロック、RTC、電源システム
PSoC 4 システム リソースは電源システム、クロック システム、リセットおよび電圧リファレンスから成ります。電源システムは
各モードに応じた電圧レベルを保証します。これを実現するために、機能の正常な動作に必要な電圧レベルを達成するまで
モードへの移行を遅延させる (例えば、パワー オン リセット (POR) の時)、またはリセット (電圧低下検出 (BOD)) か割り込み
(低電圧検出 (LVD)) を生成します。
PSoC 4 クロック システムは、クロックを必要とするすべてのサブシステムにクロックを供給し、グリッチなしに異なるクロック
ソース間で切り替えることを担当します。また、クロック システムはメタステーブル状態が発生しないように保証します。PSoC
4200L のクロック システムは 32kHz で動作する時計用水晶発振器 (WCO)、IMO (3～48MHz) と ILO (32kHz 公称) の
内部発振器、および外部クロック用のプロビジョンで構成されます。チップ上の使用可能な正確なクロック リソースについては、
それぞれの PSoC 4 デバイスのデバイス データシートをご参照ください。
表 7. システム リソース アプリケーション ノート
文書番号
文書名
®
AN86233
「PSoC 4 Low-Power Modes and Power Reduction Techniques」
AN90114
「PSoC 4000 Family Low-Power System Design Techniques」
AN96667
「PSoC Real-Time Clock Based on Power-Line Frequency」
®
®
表 8. RTC サンプル コード
文書番号
文書名
®
CE96926
「PSoC Real-Time Clock Based on Power Line Frequency」
CE95915
「Implementing an RTC with PSoC 4100/PSoC 4200 Devices」
®
表 9. システム リソース サンプル コード
文書番号
文書名
CE95322
「Hibernate and Wake Up with PSoC 4」
CE95321
「Hibernate and Stop Power Modes with PSoC 4」
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表 10. WDT サンプル コード
文書番号
5.7.5
文書名
CE95401
「Watchdog timer example using LCD with PSoC 4」
CE95400
「Watchdog timer interrupts and device reset for CY8CKIT-040 with PSoC 4000」
S AR AD C
12 ビットの 1Msps SAR ADC は 18MHz の最大クロック レートで動作でき、12 ビット変換を行うためにその周波数で少なくと
も 18 クロックを必要とします。
表 11. SAR ADC アプリケーション ノート
文書番号
AN60590
文書名
®
「PSoC 3, PSoC 4, and PSoC 5LP – Temperature Measurement with a Diode」
表 12. SAR ADC サンプル コード
文書番号
文書名
CE95275
「Sequencing SAR ADC and Die temperature sensor with PSoC 4」
CE95272
「SAR ADC in Differential Mode using Pre-Amplifier with PSoC 4」
表 13. PSoC Creator SAR ADC コンポーネント データシート
文書番号
001-96792
5.7.6
文書名
「PSoC 4 Sequencing Successive Approximation ADC (ADC_SAR_Seq)」
C a p S e n s e お よ び I D AC
PSoC 4 は、指のタッチを検出できるようにする CapSense ブロックを備えています。CapSense ブロックは、ボタン、リニアと
ラジアルスライダ、トラックパッドおよび近接センサーなどのユーザー インターフェースを実装するために使用できます。
各 CapSense ブロックには、CapSense が使用されない場合、一般的な目的に使用可能な 2 個の IDAC があります。
表 14. CapSense アプリケーションノート
文書番号
文書名
®
®
AN85951
「PSoC 4 CapSense Design Guide」
AN92239
「Proximity Sensing with CapSense 」
®
表 15. CapSense サンプル コード
文書番号
文書名
CE95297
「1.2 Volt Comparator (CSD Comp) using Analog Multiplexer with PSoC 4」
CE95289
「CapSense Proximity with PSoC 4」
CE95288
「CapSense Low Power with PSoC 4」
CE95286
「CapSense CSD using Tuner with PSoC 4」
CE95285
「CapSense CSD with PSoC 4」
CE95327
「8-Bit Current Digital to Analog Converter (IDAC8) with PSoC 4」
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表 16. PSoC Creator CapSense および IDAC コンポーネント データシート
文書番号
5.7.7
文書名
®
001-96069
「PSoC 4 Capacitive Sensing (CapSense CSD)」
001-96067
「PSoC 4 Capacitive Sensing (CapSense Gesture)」
001-96481
「PSoC 4 Current Digital to Analog Converter」
®
プログラム可能なアナログ – オペアンプおよび低消費電力コンパレータ
PSoC 4 はコンパレータ モードのある最大 4 個のオペアンプを持つことにより、ほとんどの一般的なアナログ機能が外部
コンポーネントの必要がなく、オンチップで実行できます；PGA、電圧バッファ、フィルタ、トランスインピーダンス アンプ、とその
他の機能は外部受動素子で実現できるため、電力、コスト、およびスペースを削減できます。PSoC 4 は、ディープスリープと
ハイバネート モードで動作できる、最大 2 個の低消費電力コンパレータを内蔵しています。これにより、低消費電力モード中
に外部電圧レベルを監視する能力を維持しながらアナログ システム ブロックを無効にすることができます。
表 17. オペアンプ サンプル コード
文書番号
文書名
CE95341
「Operational Amplifier (OpAmp) with PSoC 4」
CE95340
「Amplifier with Dynamic Gain Switching with PSoC 4」
表 18. コンパレータ サンプル コード
文書番号
文書名
CE95360
「Scanning Comparator using common mode with PSoC 3/4/5LP」
CE95293
「Analog Voltage Comparator with PSoC 4」
CE95338
「Multiplexed Analog Comparator with PSoC 4」
CE95333
「Low Power Comparator with PSoC 4」
表 19. PSoC Creator オペアンプおよび低消費電力コンパレータ コンポーネント データシート
文書番号
5.7.8
文書名
001-92541
「PSoC 4 Operational Amplifier (Opamp)」
001-92647
「PSoC 4 Low Power Comparator」
001-90677
「1.2 Volt Comparator (CSD Comp)」
TCPWM
PSoC® 4 内のタイマー、カウンター、パルス幅変調器 (TCPWM) ブロックは 16 ビット タイマー、カウンター、パルス幅変調器
(PWM)、直交デコーダーの機能を実装しています。ブロックは入力信号の周期とパルス幅の測定 (タイマー) や特定のイベント
が発生する回数のカウント (カウンター)、PWM 信号の生成、直交信号の復号に使用します。
表 20. TCPWM アプリケーション ノート
文書番号
AN93637
文書名
®
「PSoC 4 Sensorless Field-Oriented Control (FOC)」
表 21. TCPWM サンプル コード
文書番号
文書名
CE95354
「Quadrature Decoder with PSoC 4」
CE95351
「Fixed Function PWM with PSoC 4」
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文書番号
文書名
CE95349
「Pseudo Random Sequence (PRS) generator with PSoC ¾/5LP」
CE95385
「TCPWM Timer/Counter Operation with PSoC 4」
CE95380
「TCPWM configuration with PSoC 4」
表 22. PSoC Creator TCPWM コンポーネント データシート
文書番号
001-92448
5.7.9
文書名
「PSoC 4 Timer Counter Pulse Width Modulator (TCPWM)」
S C B – I 2 C 、 S P I 、 U AR T
PSoC 4 は 4 個の SCB を内蔵しています。それぞれは I2C、UART、または SPI インターフェースを実装できます。
表 23. CSB サンプル コード
文書番号
文書名
®
CE96999
「Basic LIN Slave Implementation in PSoC 4」
CE95325
「I2C LCD with PSoC 4」
CE95366
「UART Transmit and Receive using a Serial Communication Block (SCB) with PSoC 4」
CE95365
「SPI Transmit and Receive using a Serial Communication Block (SCB) with PSoC 4」
CE95364
「I2C Slave using a Serial Communication Block (SCB) with PSoC 4」
CE95363
「I2C Master using a Serial Communication Block (SCB) with PSoC 4」
CE95362
「Cypress EzI2C communication using a Serial Communication Block (SCB) with PSoC 4」
CE95345
「PM Bus Slave in Thermal Management Application with PSoC 4」
CE95389
「UART Transmit with PSoC 3/4/5LP」
CE95388
「UART Receive with PSoC 3/4/5LP」
表 24. PSoC Creator SCB コンポーネント データシート
文書番号
文書名
001-96075
「PSoC 4 Serial Communication Block (SCB)」
5.7.10 UDB
ユニバーサル デジタル ブロック (UDB)は、PSoC に既に存在しているリソースから別のカスタム デジタル論理を作成する
ために使用可能なプログラム可能なデジタル ブロックです。PSoC Creator は UDB からできている PWM、カウンター、
UART、SPI、I2S およびその他の多くの一般的に使用されるデジタル ブロックに対してコンポーネントを提供します。
上記以外には、UDB はステータス マシーンまたはカスタム通信プロトコルの作成にも使用できます。ユーザーの設計に OR、
AND、XOR などの論理ゲートを追加するためにも使用できます。
PSoC 4 は最大 8 個の UDB を内蔵しています。また UDB アレイは、通信と制御用にペリフェラルとポートからの信号を UDB
に、また UDB を介して送信することを可能にする切り替えられたデジタル システム相互接続 (DSI) ファブリックを提供してい
ます。
表 25. UDB アプリケーション ノート
文書番号
文書名
®
AN82156
「PSoC 3, PSoC 4, and PSoC 5LP – Designing PSoC Creator™ Components with UDB Datapaths」
AN82250
「PSoC 3, PSoC 4, and PSoC 5LP – Implementing Programmable Logic Designs with Verilog」
AN60024
「PSoC 3, PSoC 4, PSoC 5LP Switch Debouncer and Glitch Filter」
AN62510
「Implementing State Machines with PSoC 3, PSoC 4, and PSoC 5LP」
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表 26. UDB サンプル コード
文書番号
文書名
CE95319
「Hardware Glitch Filter with PSoC 3/4/5LP」
CE95348
「Precise Illumination Signal Modulation (PrISM) with PSoC 3/4/5LP」
CE95298
「Switch Debouncer with PSoC 3/4/5LP」
CE95294
「7-bit Down Counter with PSoC 3/4/5LP」
CE95334
「Lookup table (LUT) with PSoC 3/4/5LP」
CE95386
「TMP05 temperature sensor interface with PSoC 3/4/5LP」
5 . 7 . 1 1 C AN
PSoC 4 CAN ペリフェラルは、最大 1Mbps の通信ボーレートに対応できるフル機能のコントローラー エリア ネットワーク
(CAN) です。PSoC 4200M および PSoC 4200L は 2 個の独立した CAN 2.0B ブロックがあり、これらのブロックが CAN に
準拠していると認証されます。
表 27. CAN サンプル コード
文書番号
CE97311
文書名
®
®
「PSoC 4 M: CAN Simplex Communication with CapSense 」
表 28. PSoC Creator CAN コンポーネント データシート
文書番号
文書名
001-85034
「Controller Area Network (CAN)」
5.7.12 ユニバーサル シリアル バス (USB)
PSoC 4 はフルスピードの USB 2.0 対応のデバイス インターフェースを備えています。1 個の制御エンドポイントと 8 個の
他のエンドポイントがあります。このインターフェースは USB トランシーバーがあり、IO からクロック供給されて動作するため、
水晶発振器の必要性を除去します。
5.7.13 セグメント LCD ドライブ
PSoC 4 は、最大 8 コモン信号と最大 56 セグメント信号を駆動できる 1 個の LCD コントローラーを内蔵しています。
各ピンはコモン ピンかセグメント ピンになり得ます。内部 LCD 電圧を生成する必要のないフル デジタル方式を使用して LCD
セグメントを駆動します。
表 29. セグメント LCD アプリケーション ノート
文書番号
AN87391
文書名
®
「PSoC 4 Segment LCD Direct Drive」
表 30. セグメント LCD サンプル コード
文書番号
文書名
CE95369
「Segment LCD with PSoC 4」
001-88604
「PSoC 4 Segment LCD (SegLCD)」
5.7.14 GPIO
PSoC 4 は 124 ボール VFBGA パッケージで最大 98 本の GPIO があります。ピンは、8 ビット幅のポートと呼ばれる論理エンティ
ティに構成されています。
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表 31. GPIO アプリケーション ノート
文書番号
AN86439
文書名
®
「PSoC 4 – Using GPIO Pins」
表 32. PSoC Creator ピン コンポーネント データシート
文書番号
001-92674
文書名
「Pins」
5.7.15 スマート IO™
PSoC 4 はそのいくつかのポートに対応するスマート IO コンポーネントがあり、GPIO ポートとさまざまな周辺機器およびソー
スからそれへの接続の間に介入されるプログラマブル ロジック構造体を提供します。スマート IO はスイッチと LUT の構造体
であり、ブール関数を GPIO ポートの各ピンに送信されている信号で実行することを可能にします。I/O ピンから行ったり来た
りする信号に対して簡単な論理演算およびルーティングを実行する必要があると、スマート IO コンポーネントを使用する必要
があります。各スマート IO コンポーネントは特定の GPIO ポートに対応し、完全にポートを使用します。コンポーネントが使用
されない場合、そのポートのためのスマート IO 機能がバイパスされます。
表 33. スマート I/O のサンプルコード
文書番号
文書名
®
®
CE209974
PSoC 4 Breathing LED with Smart IO
CE209975
PSoC 4 Clock Buffer with Smart IO
CE209976
PSoC 4 SPI Slave Select Inversion with Smart IO
®
®
®
®
5.7.16 プログラムおよびデバッグ
PSoC 4 のプログラムおよびデバッグ インターフェースは、外部デバイスがプログラムとデバッグ処理を実行するための通信
ゲートウェイを提供しています。その外部デバイスは、サイプレスが提供するプログラマやデバッガまたは PSoC 4 のプログラム
およびデバッグに対応するサードパーティのデバイスです。シリアル ワイヤ デバッグ (SWD) インターフェースは、外部デバイスと
PSoC 4 間の通信プロトコルとして使用されます。
表 34. プログラムおよびデバッグ アプリケーション ノート
文書番号
文書名
®
AN84858
「PSoC 4 Programming Using an External Microcontroller (HSSP)」
KBA93541
「Using the CY8CKIT-049 to Program Another PSoC 4」
5.7.17 システム レベル アプリケーション ノートおよびサンプル コード
表 35. システム設計アプリケーション ノート
文書番号
文書名
®
AN57821
「PSoC 3, PSoC 4, and PSoC 5LP Mixed-Signal Circuit Board Layout Considerations」
AN81623
「PSoC 3, PSoC 4, and PSoC 5LP Digital Design Best Practices」
AN88619
「PSoC 4 Hardware Design Considerations」
AN2155
「PSoC EMI Design Considerations」
AN89056
「PSoC 4 – IEC 60730 Class B and IEC 61508 SIL Safety Software Library」
AN80994
「PSoC 3, PSoC 4, and PSoC 5LP EMC Best Practices and Recommendations」
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表 36. ファン コントローラー アプリケーション ノート
文書番号
AN89346
文書名
®
「PSoC 4 Intelligent Fan Controller」
表 37. ブートローダ アプリケーション ノート
文書番号
文書名
®
AN68272
「PSoC 3, PSoC 4, and PSoC 5LP UART Bootloader」
AN73854
「PSoC 3, PSoC 4, and PSoC 5LP Introduction to Bootloaders」
AN86526
「PSoC 4 I2C Bootloader」
®
®
表 38. キャラクタ LCD サンプル コード
文書番号
文書名
CE95291
「Char LCD using Horizontal Bar Graph (Hbar) with PSoC 4」
CE95290
「Char LCD using Custom Font with PSoC 4」
表 39. ファン コントローラー サンプル コード
文書番号
文書名
CE95318
「Firmware Fan Control with PSoC 3/4/5LP」
CE95315
「Auto Firmware Fan Control with Alert with PSoC 4」
表 40. ブートローダ サンプル コード
文書番号
文書名
CE95281
「Bootloader Project with PSoC 4」
CE95280
「Bootloadable Project with PSoC 4」
表 41. その他のサンプル コード
文書番号
文書名
CE95329
「Compensation of ILO Trimming with PSoC 4」
CE95296
「Cyclic Redundancy Check with PSoC 3/4/5LP」
CE95379
「Software based UART transmit with PSoC 3/4/5LP」
表 42. PSoC Creator システム レベル コンポーネント データシート
文書番号
文書名
001-92648
「Bootloader and Bootloadable」
001-85137
「Interrupt」
001-96071
「PSoC Creator™ System Reference Guide (CY_Boot Component)」
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6
まとめ
本アプリケーション ノートは PSoC 4 アーキテクチャおよび開発ツールを説明しました。PSoC 4 は、単一チップ上に設定可能な
アナログとデジタルのペリフェラル機能、メモリ、および ARM Cortex-M0/M0+マイクロコントローラーを集積した、真のプログラマ
ブル組込みシステム オン チップです。集積した特長と低リーク電力モードのおかげで、PSoC 4 は、低消費電力とコスト効率
の高い組み込みシステムに最適です。
また、本アプリケーション ノートは PSoC 4 を迅速に深く理解できるように情報リソースを総合的に集約しており、それらへの
アクセスを提供します。
著者について
氏名:
Nidhin M S
職位:
上級アプリケーション エンジニア
経歴:
Nidhin は電子通信工学の学士号を取得して GEC Thrissur を卒業しました。彼の技術分野はアナログ信号処
理、低消費電力設計、および静電容量タッチ センシングです。
氏名:
Ranjith M
役職:
上級アプリケーション エンジニア
経歴:
Ranjith は GEC (トリチュール、インド) を卒業し、電子通信工学の学士号を取得しました。彼の技術分野は通信
プロトコル、デジタル論理デザインおよびデバイス プログラムです。
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ワールドワイド販売と設計サポート
サイプレスは、事業所、ソリューション センター、メーカー代理店および販売代理店の世界的なネットワークを持っています。お客様の
最寄りのオフィスについては、サイプレスのロケーション ページをご覧ください。
PSoC®ソリューション
製品
車載用
cypress.com/go/automotive
psoc.cypress.com/solutions
クロック & バッファ
cypress.com/go/clocks
PSoC 1 | PSoC 3 | PSoC 4 | PSoC 5LP
インターフェース
cypress.com/go/interface
サイプレス開発者コミュニティ
照明 & 電源管理
cypress.com/go/powerpsoc
コミュニティ | フォーラム | ブログ | ビデオ | トレーニング
メモリ
cypress.com/go/memory
PSoC
cypress.com/go/psoc
タッチ センシング
cypress.com/go/touch
USB コントローラー
cypress.com/go/usb
ワイヤレス／RF
cypress.com/go/wireless
テクニカル サポート
cypress.com/go/support
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